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LIMITED WARRANTY NOTICE

Sierra On-Line, Inc. wants your continued business. If you fill out the enclosed product
registration card and return i 1o us, you are covered by our warranty. If your software
shauld fail within 90 days of purchase, return it to your dealer or directly 1o us, and we will
roplace i free. After 90 days, please enclose 35 lor 5.25" disks andfor $10 for 3.5
disks,and return the software directly to us. Sorry, without the registration card you are
ot covered by the warranty. This warranty gives you specific legal nights, and you may
also have other rights which vary from stale 10 state.

COPYRIGHT NOTICE
Unauthorized copying of this program disk and the documentation may be a violation of
Federal Criminal Laws (Tile 17 USC Section 506). Violation may carry a fine of $25,000
or imprisonmant or bath,
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SPACE QUEST III

Al the end of Roger's adventure in Space Quest 1, he had
narrowly escaped death aboard Sludge Vohaul's asteroid
foriress. Entering an cscape pod, he rocketed away scconds
before it burned up in the Labionian atmosphere.

Shortly after blasting away, he discovered his oxygen
supply near depletion. Making a last ditch effort to survive,
he climbed into the hibernatic sleep chamber with the hope
that someone would find him soon.

Now, an indeterminate amount of time has passed, and the
small pod drifts aimlessly through deep space. Time stands
still for our hero in suspended animation.
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GETTING STARTED: FLOPPY DRIVES

It is always advisable to make back-up copies of your master program disks, (o increase the
life of the masters and guard against accidents. Follow your computer’s instructions to make
copies of all game disks.

If you will be playing from floppy disks, rather than a hard disk, you will also want to format
a blank disk for saving games. Follow your computer”s instructions to format a blank disk and
keep it handy for saving your game as you play.

[MSD0S]

INSTALL THE GAME

Place your disk 1 (or its back-up) into your floppy disk drive. Type the letter of the disk drive
you just placed the disk into followed by a colon and press ENTER (eg. A:). Type INSTALL
and press ENTER. Answer the onscreen questions using the up and down arrow keys to
highlight your selections. You will be asked if you wish to install the game on your hard disk.
If you do not wish the game 1o be installed on your hard disk, then press ESC (to skip this
step). Otherwise enter the letter designation of your hard disk (usually C) and follow the
prompis.

Please Note: The install pmcednrc wil! write a file named RESOURCE.CFG o disk 1. For
the lation to be ¢ | , DISK 1 MUST NOT BE WRITE PROTECTED.
No other files on disk 1 m writien or changed by the INSTALL command.

LOADING INSTRUCTIONS
1. If you are starting the game from floppy disk: Place disk 1 into the drive, type SIERRA
and press ENTER.
2. If you are starting the game from hard disk: Type CD \SIERRA and press ENTER.
Mext type SQ3 and press E
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LOADING INSTRUCTIONS

Please Note: If you are using an Atari 520 ST without memory expansion, you should
not run your Sierra game with any desk accessories installed.

. If you are playing the game from floppy disk: Place disk 1 in drive A, open the disk by
double-clicking on its icon, then start the game by double-clicking on SIERRA.PRG.
2. If you are playing the game from a hard disk: Open the disk by double-clicking on its
icon, then open the game folder by double-clicking on the game folder icon. Start the

game by double-clicking on SIERRA.PRG.



HARD DISK INSTALLATION

. If you are playing from a hard disk, first make sure you have enough space on the hard
disk for the game -- single-click on the disk icon, then select Show Info.. from the File
menu. Bytes Available should be at least 800,000 times the number of floppy disks
included with the game.

Open the hard disk by double-clicking on its icon,

. Create a game folder by choosing New Folder... from the File menu. Open the new
folder by double-clicking on its icon.

Place the first game disk in drive A.

Copy the game disk into the new folder by dragging the drive A icon into the window you
opened in Step 3. (Click on the drive A icon, while holding the mouse button down, move
the mouse arrow over the open window, then release the button, )

6. Repeat steps 4 and 5 for each of the other game disks,

7. Put the master disks away in a safe place.

CHOOSE A MUSIC DEVICE (Optional)
Your Sierra game is initially st up to play music and sounds through the Atari ST's internal
speaker. If you have one of the supported MIDI synthesizers, you may run the MUSIC
program to have the game play music through the synthesizer.
1. Open the game disk/folder by double-clicking on its icon.
2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.
3. Select “*Music Device'" from the Options menu.
4. Select your synthesizer (or **Atari ST Internal Sound™) by clicking on the appropriate
button. Then click on OK.
5. Select **Install Game** from the File menu. This will replace the RESOURCE.CFG file
on your disk.
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Please Note: It is imp to turn your synthesizer on before playing the game.

[AMIGA |
LOADING INSTRUCTIONS
From Floppy Disks:

1. Boot your system with Workbench, then insert the game disk in any drive.

2. Position the mouse pointer over the game disk icon and double click.
Please Note: If your game has more than one disk, RENAME your copies of all game disks to
remove the words ““COPY OF" from the disk name, If the words “"COPY OF" are not
removed from the disk names of all the copies, the system will continue to ask for the original
disk and will not run the game.

From Hard Disk:

1. Load Workbench and double click on your hard disk icon,
2. Double click on the SIERRA drawer.

3. Click on the drawer for the desired Sierra game.

4. Click on the game icon,



MOVING YOUR CHARACTER

You may move your character on the screen with the arrow keys, the numeric keypad, or the
mouse. To halt your character’s steps with the keypad, press the number 5, or press the last
used direction key again, Using the mouse, start movement by clicking the left mouse button
where you want the character to move.

‘GAME SPEED CONTROL

At times it may be useful to slow down the speed of the game animation in order to

tricky section, or observe something more carefully. In Space Quest 111, spoodlsmmrolled
by the + and — keys, or by selecting a choice from the Speed menu, using the mouse or
arrow keys.




SHORT CUTS FOR COMMON COMMANDS
You can use function and control keys to short cut many common commands.

Fl Help

F2 Toggle sound on/off

F3 Repeat previous command

F5 Save Game

F7 Restore (saved) Game

Fo Restart Game (from beginning)

CTRL-C  Cancel typed command line
CTRL-1 Inventory

CTRL-1 Reset Joystick

CTRL-P Pause Game

CTRL-Q  Quit Game

CTRL-R  Toggle RGB/Composite graphics mode
CTRL-S  Change Speed

CTRL-V  Change Volume

+ Increase Volume

- Decrease Volume

= Normal Volume

MENUS
When you press ESC. a menu bar will appear at the top of your screen with several menus
which can be opened to show the command choices available to you.

USING KEYS IN THE MENUS
Use the left and right arrow keys to open a menu, and the up and down arrow keys to highlight
items within a menu,

Press ENTER to select a highlighted command.
Press ESC to return to the game without choosing a command.

INTERACTING WITH THE GAME
You interact with the game by typing in commands of one or two words, or in complete
sentences. Unless otherwise instructed, follow all commands with ENTER.

EXAMPLES OF COMMON COMMANDS
You may meet characters who have messages for you. Start a conversation with them. Type:
TALK TO (whoever you wish to talk to). For example, TALK TO THE PIRATE.

You may encounter objects you need along the way. To take an object type: TAKE (the object
you want to take). For example, TAKE THE SILVER CHALICE.



Pay close attention to details. Take a close look at objects. Type: LOOK (the object you wish
to examine). For example, LOOK AT THE TREASURE CHEST.

You will need to use the objects you acquire on your journey. Type: GIVE THE (object) to
(the person or thing you wish to have the object). For example, GIVE THE BONE TO THE
HUNGRY TIGER.

RETYPING COMMANDS
If you wish to repeat a command select RETYPE from the ACTION menu or press the
SPACEBAR.

INVENTORY

If you wish to see the items you are carrying, select INVENTORY from the ACTION menu
or press the TAB key. A list of the items you are carrying will be displayed. To view an
object, click on its name with the mouse, or use the arrow keys to highlight the name and
press ENTER. Select OK or press ESC to resume play.

PAUSING YOUR GAME
If you wish to pause the game, select PAUSE from the ACTION menu. Press ESC or
ENTER 1o continue play.

SAVING YOUR GAMES
If you wish to save your game, sclect SAVE from the FILE menu. To allow for errors in
and creative exploration, it is ded that you qu ly save your game in

progress. You will alway; wanl 10 save your game before
You should also save your game after you have made significant pmgﬂ:ss in the game.

Please Note: If you're playing from floppy disks, you must have a formatted save game disk
before you can save a game.

You may name your saved games using standard English phrases. For example, if you are
standing on a sandy beach, call your saved game “STANDING ON A SANDY BEACH", or
whatever seems appropriate.

RESTORING YOUR GAME

Select RESTORE from the FILE menu. You will be prompted to select the game you wish to
restore. (On a single drive system, you will be prompted to insert your save game disk.)
Highlight the desired game and select RESTORE. * If the game you wish to restore is on a
different directory, select CHANGE DIRECTORY .

G YOUR GAME
If you wish to stop playing, select QUIT from the FILE menu.

*If you do not have & mouse, use the TAB key to highlight games.
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TIPS FOR THE BEGINNING ADVENTURER
1f you've never played one of Sierra's adventure games before, here are a
few suggestions to get you started.

INTERACTING WITH SPACE QUEST 111
You can interact with the game by typing in simple commands consisting
of as litthe as a verb and an object. For instance, the command “‘get into
lhe rail grabber** can be shortened to “‘get in grabber.” The
;wc m buckazoids to the clerk’” could be expressed as “*give money to
clerk.

Space Quest I11 will understand many common verbs. Here is a list of
some you might want (o try:

LOOK DROFP EXAMINE USE
CLIMB GET READ TALK
HIT PICK UP  PLAY KICK
PUNCH PUSH PULL MOVE
OPEN CLOSE JUMP SIT
STAND GIVE PUT ON TAKE
TAKE OFF

LOOK everywhere. When you go somewhere you haven't been before,
or where you think you may have missed something the first time, the
first thing you should do is look around. When you type “look™ on
entering an area, you will receive a description of the general area. Read
this description carefully — often there is a clue 10 the game or an
indication that something in the scene bears further investigation.

If you are standing close enough 1o a plrl.iwlir ohject you can take a
closer look at that specific thing. EXAMPLE “look at spucewlp " Press
ENTER each time you type a i to enter that

A comment window will appear each time you enter a command, and at
other times during the game. When you have read the comment, press
ENTER 1o remove the window and resume play.

EXPLORE cach area of the game very carefully. Search every area of
the garbage freighter for a way to escape. Search each area of each planet
you voyage 1o, but carefully! There are a lot of hazards out here in space.

DRAW A MAP that includes each place you visit, objects found,
dangerous areas, any and every landmark you see along the way. If you
miss an area, you may miss an important item or clue you will need to
complete your quest.
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TALK 1o almost everyone you meet, but use discretion! Some characters
will be friendly and helpful. They will give you valuable information and
advice, Others may mislead, capture, or even kill you, At times it may be
necessary to fight, at others to run away, hide or try to outwit your
opponent.

PICK UP anything that isn’t nailed down. You'll come across a number
of objects that will be of use later in the game. Some of these can be
picked up, others may have to be bought or traded for. You can see an
inventory of items on hand by pressing the TAB key at any time.

USE the items you have picked up to solve problems in the game. Some
problems have obvious solutions; if you're thirsty, uloendrml:ofwmr

Topurclmeanm you'll need some buckazoids, Other problems
require more imagination to solve,

BE CAREFUL. Remain alert at all times -- disaster may strike in the
most unlikely of places.

SAVE YOUR GAME oﬁen‘ especially when you are about to try

ing new or p That way, if the worst should
happen, ynnwnnlhnvemmnaﬂomagmnﬁunlhehegmmng (Sec
your reference card for instructions on saving your game,)

DON'T GET DISCOURAGED. If you come to an obstacle that scems
insurmountable, don't despair. Explore the game some more, then come
back later. Every problem in the game has at least one solution, and some
have more than one, Sometimes solving a problem one way will make it
harder to solve the next, and sometimes it will make it easier. If you get
stuck, you might try backtracking to an earlier point in the game, then
choosing a different path. If all else fails, you can buy a Space Quest 111
Hint Book from the dealer who sold you the game,




(WALKTHROUGH)

WARNING
The foll ion is for beginni game players
only. mmmnmudemrswmmwmesMhmsw
experienced adventurers may not wish to see. Continue reading only if
you are having difficulty getting started with Space Quest I11.

When the character has stepped out of the escape pod and the door
closes, you will have control of the character and the game will begin.

Press ENTER to remove the comment sereen that appears afier the pod
door closes.

Use mouse, keyboard or joystick 1o walk south (down) to the next area,
where several junk spaceships are stored.



While you are here, try looking around at your surroundings:
Type “look™

Walk 1o the spaceships.
Type “‘look at ship'* at each one.

‘Walk 1o a pile of junk.

Type “'look at junk’”

Walk 1o the crate in the left foreground.
Type “look at crate™

From this area, walk cast (right) to the next room,
Walk 1o the large gear in the left foreground.
Type “‘look at gear™

‘Walk to the giant arm in the background.

Type “‘look at arm™”

‘When you have explored all you want, walk to the right side of the room
until you come to a vertical conveyer that is lifting buckets up and out of
the screen. If you stand close enough, in front of the conveyer, it will
catch you and carry you to a horizontal conveyer belt which leads to the
shredding machine. At this point it would be a good idea to save your
game.

To keep from being thrown in the shredder, type ““stand”", Immediately
type *‘jump"’ to reach the rail above the conveyer. Now you will be able
o walk along the rail to begin your exploration of the ship, but BE
CAREFUL! It is still possible to slip and fall o your death. NOTE: If
you have been using a mouse or joystick to move the character, you
might want to switch to the ARROW keys for tricky sequences like this
one.

When you are up on the rail, walk west (left) until you come to an
opening in the ship’s bulkhead. On the other side, hanging from the rail,
is a rail-grabber car. Walk close to it and type “‘get in grabber. You
are Now on your way 1o exploring your new environment,

Good luck, and remember, those Two Guys are counting on you!



NEED A HINT?

I you find yourself **a litthe stuck™ while playing a Sierra
game, try the following ideas:

1. If you have a modem, you can talk to the Sierra Bullctin
Board* through the following number:

(209) 683-4463

Our sysop, will be happy to help you.
*Settings: 12008PS, B Dats, ¥ Parity, | Siop Bi. (Sierra BES docs not
suppon

2400 Bawd.)

2. Many other bulletin boards also provide hints to many
of our games.

Al
B.

Compuserve: Go into the Gamers Forum (GO
GAMERS) or write E-Mail to 76004,2143.
Prodigy: Write E-Mail to ““HTWS%0A™, or go to
the PC Club and enter the adventure games forum
{Jumpword: PC CLUB).

. PCLink: Select PCLink Plus, enter Publisher's

Connection, select Publisher’s Forums, then
Sierra On-Line. E-Mail may be written to the User
ID **Sierra On Li™.

. AppleLink: Select the keyword option from the

““Goto™" menu, and type “'Sierra’”. E-Mail may
also be written to the User 1D *“Sierras™.

. GEnie: From the main menu select 10 (Games),

then select 1 (Games Round Table). Select |
{Games Bulletin Board), and type **set 22" at the
*+1"* prompt. This will take you into the Sierra On-
Line area.

For more information on these BBS lines, you can
call these toll-free numbers:

1. Compuserve (BOO0) B4B-8199
2. Prodigy 8226922
3. PCLink (800) 458-8532
4. AppleLinks (BO0) 227-6364
5. GEnie (BO0) 638-9636

3. The magazine Questbusters' Journal is a helpful source
of many game hints.

4. Your local software dealer may carry our hint books, or
may be willing to order them for you,




5. If you are unable to obtain a hint book through a dealer,
you can order one directly from us. Call (800)
344-7448 10 place your order with a Visa or
MasterCard, or write Sierra On-Line, Inc., Order
Department, P.O. Box 485, Coarsegold, CA 93614,

6. If the hint book is not available for the game you are
playing, call our Customer Service line at (209)
683-6858, to receive a hint.

PROBLEM DISK?
If you are having problems with a disk, try these suggestions
before assuming the disk is faulty:

1. If you receive the message ““Insert Disk # __'" when
you have already inserted that disk, then you may need
10 change your config.sys file to include the command
“files = 15", If you are not familiar with changing
your config.sys file, see your DOS manual.

2. If you receive the message “*Out of Handles™ or **Out
of Heap'* or if the game locks up at any point, you may
have memory resident programs loaded on your hard
drive. Boot your system from a floppy disk conaining
DOS only. You may need w add the config.sys file
described above.

("

. If you receive the message “‘Disk Error' follow
instructions 1. or 2. above. If this does not clear the
“Disk Error” message, you will need w send for
replacement disks.

Send the original disk 1o:
Sierra On-Line, Inc.
P.O. Box 485
Coarsegold, CA 93614
Attn: Returns
Be sure to include a note stating your computer type, and the
size of disk you need (5.25° or 3.5").

There is no charge if the request is made within 90 days of
purchase (enclose a copy of your receipt). Afier 90 days,
there is a $5 charge for 5.25"" disks, and a $10 charge for
3.5 disks.

16



SIERFA ON-LINE, INC. « COARSEGOLD, CA G3614 + (208) 603-6850
TM designates trademark of Serra On-Line, Inc. * is a reglstered trademark of Sierra Gn-Line, inc.
1589 Slerra On-Line, Inc. Printed in the U.S.A.
002841000



